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System Description 

 
Two types of RC PIC Analyzer are available from Hiden Analytical Limited; the Standard 
System and the Series 1000 System. 
Standard systems are available with either single or triple filter Probes and mass range 
options of 100, 200, 300 and 510 amu. The Series 1000 System offers an increased mass 
range (up to 2500 amu), or increased sensitivity at lower masses, compared with the 
Standard Systems. 
 
A complete Standard System comprises an RC Interface unit (IU), a Radio Frequency (RF) 
Head, an RC PIC Probe (which is installed within the vacuum system) and all the required 
interconnection cabling, see Figures 1.1 and 1.2. 
 
In Series 1000 systems the RF generator is not fitted in the Head; it is located in a separate 
RF Generator Unit, hence a complete Series 1000 System comprises an RC Interface unit 
(IU), an Amplifier Head, a Series 1000 RF Generator Unit, an RC PIC Probe (which is 
installed within the vacuum system) and all the required interconnection cabling, 
 
Note 
1. The Feedthrough Adapter is sometimes referred to as the Probe Connector Interface 
Unit. 
2. The RC Interface unit is also referred to as the Mass Spectrometer Interface Unit 
(MSIU). 
 
In both Standard and Series 1000 Systems the instrument is operated via an IBM-
compatible Personal Computer (PC) running Hiden Analytical Limited’s MASsoft application 
under Microsoft Windows. The PC may be supplied by Hiden Analytical Limited or provided 
by the user. The MASsoft application provides complete control and tuning of the instrument; 
also data acquisition, storage, recall and analysis within the Microsoft’s Windows 
environment. Version 4 of the MASsoft application is described fully in Hiden Analytical 
Limited Manual number HA-085-067, “MASsoft Version 4 User Guide”. Older versions of 
MASsoft are described in the Hiden Analytical Limited Manual number HA-085-004, 
“MASsoft User Manual”. Whenever referred to the “MASsoft User Manual” in this manual 
use the MASsoft manual relevant to the version of software being employed. 
 
RC PIC systems include a parameter scan mode to map species intensity against 
appearance potential and beam tune parameters. 
 
Instruments may be supplied for mounting directly in a vacuum chamber or as systems for 
sampling higher pressures. In a high pressure sampling system the Probe is mounted in a 
chamber and includes pumps, valves and the associated drive units mounted in a small rack 
or cubicle. 
 
For optimum performance, the RF (or Amplifier) Head is mounted on the Probe and is 
connected to it via a 12-way feedthrough. In Standard Systems the RF Head contains signal-
conditioning electronics, an RF power supply (for the quadrupole mass filter) and wiring to 
connect the IU-generated signals and voltages to the Probe. In Series 1000 Systems, the RF 
power is generated in the separate RF Generator Unit, not in the Amplifier Head. 
 
In Standard Systems, the RC Interface is connected to the RF Head; in Series 1000 
Systems the RC Interface is connected to the Series 1000 RF Generator Unit via the 
Amplifier Head. 



 
 
 

Document Prepared by Ian Tyrer-Tomkinson  Page 3 of 84 

The RC Interface is standard for both types of System; it is a 2U rack-mountable unit 
containing the control computer, communications interfaces, mains power supply and the 
electronics which supply the voltages and control signals to the Head and Probe. RS232 or 
Ethernet Local Area Network (LAN) may be used to communicate with the control PC, which 
may be several hundred metres away from the RC Interface, depending on the link used. 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 
 
 

Document Prepared by Ian Tyrer-Tomkinson  Page 4 of 84 

HPR 20-QIC Vacuum System 
 
HPR-20 QIC systems are designed to be simple tools for gas analysis. They provide fast 
sample response times combined with accurate, repeatable results in a user-friendly 
package. 
 
All inlet systems are supplied pre-assembled and fully tested; they require minimum 
preparation and assembly prior to operation. 
 
The basic system comprises an Ultra-High Vacuum (UHV) housing, inlet system, turbo 
molecular (turbo) pump and gauges. 
 
The standard HPR-20 QIC inlet system is bypass pumped and utilizes a two meter long 
capillary sampling line. The inlet is connected directly to the Mass Spectrometer ion source 
for enhanced performance. 
 
The capillary and inlet are heated to improve condensable species sampling. 
 
The standard HPR-20 QIC is suitable for sampling from 0.1 to 2 bar (absolute), alternative 
configurations for sampling pressures from 1x10-4 mbar to 10 bar are available. 
 
Each HPR-20 QIC system is integrated with one of the Hiden Analytical Limited range of 
Quadrupole Mass Spectrometers. These range from the basic HAL Series 2 100 amu mass 
range unit to the high sensitivity 3F triple-filter quadrupole with mass ranges to greater than 
500 amu and partial pressure detection down to 1x10-14 Torr. 
 
The Mass Spectrometer Probe and total pressure gauge are mounted in the UHV housing. 
 
Ports are provided for the turbo pump and inlet system. 
 
The UHV turbo molecular pumping set is connected to the UHV housing and comprises: 

• Turbo pump. 
• Turbo pump backing pump; this is a two-stage rotary pump or a diaphragm 
(membrane) pump. The turbo pump and diaphragm backing pump provide an oil-free 
vacuum in the UHV housing. 
• Drive electronics. 
• Vacuum controller. 
• Venting device. 

 
The turbo pump typically has 60 L/s pumping speed when used with a DN-63-CF Conflat-
type flange. 
 
The vacuum controller in an HPR-20 with Pfeiffer pumps will be a Hiden Analytical Turbo 
Interface and Power Unit (TIPU). In HPR-20 systems fitted with Edwards pumps the vacuum 
controller is a Power Supply and Trip Unit (PSTU) operating in conjunction with the Edwards 
Turbo Instrument Controller (TIC). 
 
The vacuum controller interfaces the turbo pump controller, backing pump and venting 
operations; it also gives a single switch start-up of the pumping set. It also provides 
interlocking for protecting the Mass Spectrometer ionisation source filaments. 
 
Automatic venting protects the Mass Spectrometer and UHV housing from pump oil 
contamination when the turbo pump is not running. 
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The HPR-20 System 

 

The HPR-20 Components 

The HPR-20 system and indeed most other systems from Hiden contain the following parts; 

MSIU The MSIU or RC Controller Unit is the main communication from PC 

to Gauge Head.  The communication to PC is via RS232, LAN (Local 

Area Network) or USB.  It also controls the voltages applied to the 

Gauge Head via the RF Head. 

RF Head The RF Head supplies the Gauge Head with RF (Radio Frequency) 

and DC for the Mass Filter, which is used to ‘filter out’ the Ions of 

interest.  Each Ion has a distinct DC and RF voltage, which enables it 

to pass through the Mass Filter, all other Ions are discarded. 

Gauge Head The Gauge Head, situated inside the Vacuum housing is comprised of 

the Mass Filter, Ion Source, Filaments and detector(s).  The Gauge 

Head is explained in more detail in the ‘Basic Principles of Hiden RGA 

Mass Spectrometers’ section. 
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Capillary The Capillary is a heated inlet which contains an inert silica coated 

glass liner available in 2 lengths 2m and 0.9m to suit the application, 

and is also available with different flow rates; Standard, Medium, Low 

and Very Low Flow depending on application and preference.  The 

Capillary requires to be connected to ‘T’ at the sample end with a 

minimum pressure of 1atm. 

Bypass Valve The Bypass Valve permits control over flow rate into the Mass 

Spectrometer, should more or less signal be required.  Approx. 99% of 

the sample is pumped away through the Bypass Pump, approx. 1% 

being admitted into the system. 

CPS The Capillary Power Supply supplies the power to heat the capillary, 

this is a factory set temperature, adjustment is possible, if required 

please contact Hiden Analytical as permanent damage may occur it 

set too high. 

Penning Gauge The Penning Gauge is the Total Pressure Gauge, which is gas 

dependent.  If a bulk gas is used to transfer sample down the capillary 

you can change the gas being measured to the bulk gas via the 

Edwards TIC Unit.  The Total Pressure measurement is displayed on 

the Edwards TIC, and can, in some cases is able to be ported into 

MASsoft. 

Edwards TIC The Edwards TIC or Turbo Instrument Controller controls the vacuum 

pumps and the Penning Gauge.  It also has the facility to control the 

External Trip on the MSIU controller for added protection to the 

Vacuum Gauge Head. 
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Hiden Analytical Gauge Heads 

 



 
 
 

Document Prepared by Ian Tyrer-Tomkinson  Page 8 of 84 

Basic Principles of Hiden RGA Mass Spectrometers 

The Hiden RGA Mass Spectrometer consists of an Ion Source, a Quadrupole Filter and 

Detector. 

 

 

HAL 201 Gauge Head 

The Filaments in the Ion Source are used to create an Electron Beam , which via Electron 

Impact inside the Source Cage converts the gas molecules into charged particles, or +ve 

Ions. 
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Ion Source 

The +ve Ions generated inside the Ion Source are then extracted via the Focus plate which 

is at a potential of -90V, these then enter the Quadrupole Mass Filter.  The Focus plate also 

repels the Electrons back into the Ion Source so they do not enter the Mass filter.  The basic 

Mass filter, or Single Filter has RF and DC voltages applied to it thus enabling Mass 

Separation.  Each mass has a specific RF and DC voltage on the mass filter allowing it to 

pass through to the detector. 

The simplest detector is the Faraday Bucket, which is essentially a passive conductor in the 

shape of a cup which collects the +ve Ions which are allowed to pass through the mass filter.  
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The +ve Ions create a charge when they hit the Faraday Bucket equivalent to 10-4 Amps/Torr 

for Nitrogen, which basically means 1 Torr (Partial Pressure) of Nitrogen will generate an Ion 

Beam of 10-4 Amps. 

The minimum detectable partial pressure using a Faraday bucket is in the region of           

10-11Torr, which is equivalent to 10-15Amps of Ion Current. 

The Gauge Head photo previously is a HAL 201, which has two detectors, the Faraday 

Bucket and the Secondary Electron Multiplier (SEM) 

 

 

Dual Faraday/Secondary Electron Multiplier Detector 

The Electron Multiplier has a surface which is designed to generate secondary Electrons.  A 

single Ion arriving at the surface generates (possibly) 2 or 3 Electrons; these in turn travel 

down the ‘trumpet’ of the detector which causes more collisions with the surface which 

generate more Electrons in a cascade effect until it reaches the collector. 

The power for the cascade generation is provided by a voltage applied to the SEM.  The 

overall gain achieved by the SEM above is typically 103 or 1000 gain.  The voltage applied to 

create this gain is between 800V and 3000V depending on system type and application. 
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Cracking Patterns 

Each gas molecule has its own characteristic cracking pattern, or spectral fingerprint.  This is 

caused by the molecule fragmenting when it is ionized; the effect being that almost every 

species is represented by a family of ions of differing mass/charge ratio.  Therefore the 

spectra produced can be interpreted by identifying these family groups. 

For example consider Carbon Monoxide (CO) which is a simple compound made up of 

Carbon (C) and Oxygen (O). 

 Carbon has a molecular weight of 12. 

 Oxygen has a molecular weight of 16. 

Therefore Carbon Monoxide (CO) has a molecular weight of 28, and hence will be detected 

by the Mass Spectrometer at 28. 

This is true, but there are also additional factors, namely Doubly Charged Peaks. 

When CO forms a +ve Ion it loses and electron in the Ion Source, this is written as CO+ 

Some of these Ions will also lose an additional electron and hence be doubly charged CO++ 

the ratio of CO++/CO+ is reproducible for a given instrument. 

For CO this ratio is relatively small (0.005% of Mass 28), but for other species, Nitrogen and 

Argon for example this is closer to 0.1% 

These Doubly Charged peaks Ions appear at half the molecular weight of the ‘Parent’ ion. 

The gas molecules also fragment causing fragmentation peaks to appear, for CO the 

fragmentation process will generate Carbon Ions (C+ at mass 12) and Oxygen Ions (O+ at 

mass 16) 

Most atomic species also have associated Isotope Peaks, in the case of Carbon, it has an 

Isotope Peak at mass 13 (C13 0.011% of mass 12) and also at mass 14, but this is so small it 

is generally ignored. 

Oxygen has Isotopes O17 (0.0004% of mass 16) and O18 (0.002% of mass 16) 

Therefore the fragmentation of a simple molecule such as CO can be complex with several 

identifiable peaks above the 1% component level; 

  C12+ appearing at Mass 12 

  O16+ appearing at Mass 16 

  C12O16+ appearing at Mass 28 

  C13O16+ appearing at Mass 29 

The presence of CO can therefore be established by the presence of the characteristic 

cracking pattern. 
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For simple RGA applications this is relatively easy, the primary interest being to confirm that 

the vacuum system status is consistent.  Components of interest being that of Hydrogen, 

Helium, Water, Air and Argon are easily identified. 

The interpretation of more complex species can however be a bit more difficult, but various 

tools are available raging from Cracking Pattern tables to sophisticated spectral libraries 

some of which are integrated into the Mass Spectrometer, others are available on-line such 

as the NIST database. http://webbook.nist.gov/chemistry/ .  This website allows you to 

search by name and by formula etc and view the Mass Spectrum of the species among 

other options available. 
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Introduction to MASsoft 
 
The Hiden Analytical Limited MASsoft mass spectrometer control software makes full use of 
the Personal Computer-based Microsoft Windows graphical interface to give the user totally 
flexible control of the mass spectrometer. 
 
MASsoft Professional Version 7operates on the following Windows platforms: 

 
Windows NT4 
Windows 2000 
Windows XP 
Windows 7 

 
For other versions of Windows please contact Hiden Analytical Limited for advice. 
 
The user can create a sequence of any type of scan by using MASsoft to create a scan tree. 
 
Each scan may be configured to measure a single mass or a range of masses with a 
specified step size - thus a scan can be the equivalent of one channel in a Multiple Ion 
Detection (MID) or Peak Select table if it has a single mass; or can operate in the equivalent 
of Bar or Histogram mode if the step size is one, or, with a smaller step size, can operate in 
peak-profile, analogue or peak-shape mode. 
 
A scan, however, is not confined to scanning the mass; any appropriate Digital-Analogue 
Converter (DAC) in the system may be scanned, thus a scan may be used for energy 
mapping. By scanning a DAC, its optimum value for a particular environment can easily be 
found. This corresponds to the MAP mode found on earlier Hiden Analytical Limited 
systems. 
 
This degree of flexibility may sometimes be more than required, so each of these modes of 
operation may be easily set up by means of a Gallery of scan types that automatically create 
the required scan tree. 
 
The full power of the graphical interface may be used directly to build scan trees that 
sequence any of these modes in any way that is required. In addition to simple one-
dimensional linear scans, multi-variant scans may be defined which allow multi-dimensioned 
optimisations or mapping, and co-variant scans allow several DACs to track together. These 
scans may be combined as required to form an “experiment”, using the graphical interface. 
 
Up to four acquisition modes of operation may be available in the system (depending on the 
mass spectrometer specification): 
 

Residual Gas Analysis (RGA) mode 
The mass spectrometer's internal ion source is used to provide positive ions 
for mass analysis. 

 
RGA Negative Ion mode 

The mass spectrometer's internal ion source is used to provide negative ions 
for mass analysis. 

 
Secondary Ion Mass Spectrometer (SIMS) Positive Ion mode 

Externally-generated positive ions are analysed by the mass spectrometer. 
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SIMS Negative Ion mode 

Externally-generated ions having a negative charge are analysed by the 
mass spectrometer. 

 
All these modes may be used within one scan tree. 
 
The system can be tuned easily; the optimum settings can be saved in a global environment 
and set at the start of the scan. Tuning can be performed at any time, including during data 
acquisition. Automatic tuning and mass alignment are also available; these may be 
configured to suit the analyser’s environment. 
 
Each mode of operation may be tuned individually. Each scan may be operated in any of the 
modes and each scan may be individually tuned, having a local environment that over-rides 
the values in the global environment. 
 
A scan tree is used to control data acquisition, but does not display the acquired data. 
The acquired data is displayed in a view, or views, associated with the scan. Multiple views 
may be created of the same data. For example, views can be simultaneously displayed 
showing a histogram view of the entire scan, an enlarged view of an area of interest, a trend 
view of peaks of interest and a tabular view of specified masses; all the views would be of 
the same data and all views would update simultaneously. 
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MASsoft Professional Version 7 

 
Opening MASsoft presents the main MASsoft window to allow opening of old scans, and 
creation of new scans. 
 

 
 

 
The Control Tabs permits access to the Gallery, which is the easiest and fastest method to 
create new scans, allowing you to choose between the following:- 
Profile Mode – Peak Profile, Bar Mode – A histogram scan, MID Mode – Trend analysis and 
Leak Detection and Map Mode, other options are available depending on your system. 
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The Gallery Tab 
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Profile Mode 
Selecting Profile opens the Profile Mode box, allowing you to set up a simple analogue scan, 
again with Start and Stop mass variables, but allows you to select how many Samples per 
mass (amu) you wish to take, also, after all parameters have been set accordingly, pressing 
the OK button automatically opens a View and starts the scan. 
 
 

 
 
 

If the scan does not automatically start, it can be started by selecting the Green Go button, 

, the scan will continue until the Amber Stop button, , is pressed, which completes 

the current scan before stopping, or the Red Abort button, , is pressed, which stops the 
scan immediately. 
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The window above is automatically created by the Profile Mode after pressing the OK button.  
This will show a mass scan in profile format, the actual data being dependant on your 
system and experiment.  The window shows the views in tiled format, the top scan being the 
Profile view and window below it is the Scan Tree Window, which contains the scan tree and 
parameters for the Profile mode scan.  
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Bar Mode 
Selecting Bar opens the Bar Mode box, allowing you to set up a simple histogram scan with 
a non-equal Start mass and a Stop mass with an increment of 1, after all parameters have 
been set accordingly, pressing the OK button automatically opens a View and starts the 
scan. 
 
 

 
 
 

As with the Profile Scan, if the scan does not automatically start, it can be started by 

selecting the Green Go button, , the scan will continue until the Amber Stop button, 

, is pressed, which completes the current scan before stopping, or the Red Abort button, 

, is pressed, which stops the scan immediately. 
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The top window is the view which is automatically created by the Bar Mode after pressing 
the OK button.  This will show a mass scan in histogram format, the actual data being 
dependant on your system and experiment.  The window behind the view is the Scan Tree 
Window, which contains the scan tree and parameters for the Bar mode scan.  
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MID Mode 
Selecting MID (Multiple Ion Detection) opens the MID Mode box, allowing you to set up trend 
scan with either a single, or multiple masses with an option of building a scan by choosing 
components from the internal Library.  After all parameters have been set accordingly, 
pressing the OK button automatically opens a View and starts the scan for each of the 
masses/components selected. 
 

 
 
 

As with the Profile Scan, if, if the scan does not automatically start, it can be started by 

selecting the Green Go button, , the scan will continue until the Amber Stop button, 

, is pressed, which completes the current scan before stopping, or the Red Abort button, 

, is pressed, which stops the scan immediately. 
 

Selection of the optimise for accuracy button, , (default Setting) optimises the scan for 
accuracy setting the standard settings of 100% Dwell and 100% Settle. 
 

Selection of the optimise for speed button,  , optimizes the parameters  for faster data 
acquisition, this is usually a trade-off between signal/noise due to the faster acquisition 
speed and is not necessarily the best choice. 
 

The add component from library button, , allows you to add components from the drop-
down list of the library.  The choice will be the major peak form the library, if there is a 
conflict with another component of the scan tree, the Alternative Peak Selection box will be 
displayed. 
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The Scan Tree below would be produced using settings in the MID Mode box above, the 
four mass trends would be displayed on a single view during data acquisition, these would 
be plotted against time. 
 
The other selection buttons are as follows:- 
 

 Insert component button, . Will add a new component after the currently selected 

component. 
 

 Delete component button, . Deletes the selected entry from the components list. 
 

 To Top button,  . Moves the selected component to the top of the components list. 
 

 Move Up button,  . Moves the selected component up one place in the 
components list. 

 

 Move Down button, . Moves the selected component up one place in the 

components list. 
 

 To Bottom button,  . Moves the selected component to the end of the components 
list. 
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Leak Detect Mode 
Selecting Leak Detect opens the Leak Detection Mode box, which sets the variables to build 
a scan tree for easy leak detection.  It allows you to select which mass to use for the 
detection, usually He, mass 4. It also allows you to set an upper and lower limit for the 
detection process, and if required an audible alarm.  After all parameters have been set 
accordingly, pressing the OK button automatically opens a View and starts the scan 
 

 
 
 

As with the Profile Scan, if, if the scan does not automatically start, it can be started by 

selecting the Green Go button, , the scan will continue until the Amber Stop button, 

, is pressed, which completes the current scan before stopping, or the Red Abort button, 

, is pressed, which stops the scan immediately. 
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Map Mode 
Selecting Map opens the Map Mode Scan box, allowing you to set up a simple linear scan 
with a choice of which variable to scan, and which mass to use.  It allows you to select the 
Start and Stop for the variable being mapped, how many steps you wish to use, and the 
amount of cycles you wish to scan. 
 
Map scans are useful for selecting suitable variables operating points, for setting limits for 
auto-tune operations (usually SIMS instruments), or for appearance potential experiments 
where Electron Energy is scanned. 
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Creating your own Scans 
 

Scan Tree Window 
The MASsoft window holds the scan tree window (or windows: several scan tree windows, 
for different instruments, or for the same instrument, may be open at the same time). See 
below. 
 

 
 

The scan tree window title bar contains the name of the instrument and its access status (i.e. 
“Available” or “Unavailable”). Each scan tree window contains a description of the way the 
instrument behaves when asked to acquire data, in the form of a graphical diagram, or scan 
tree.  The total description held in the window is called an “experiment”; it comprises a series 
of environment, scan and scan control boxes. This description may be modified by adding 
extra environments and scans, and by altering their variable values. The contents of the 
scan control boxes in the scan tree window can be edited by double-clicking on them. 
 
The scan is the heart of the mass spectrometer controller; the Hiden Analytical Limited scan 
generators have been designed to be powerful and as flexible as possible. 
 
A scan can be one of three types: 
 

1 A simple scan, where a single variable is scanned by incrementing between 
defined start and stop values. 

 
2 A co-variant scan, where two or more scans are linked so that each updates 

its output before another data point is acquired; it is used to  allow variables to 
track one another. 

 
3 A multi-variant scan, where two or more scans are linked so that subordinate 

scans perform a complete scan before the next higher scan in the tree 
updates its output.  Several scans may be linked to form one multi-variant 
group.  A multi-variant scan may be used to perform multi-variant surface 
mapping (not used in RGA) 

 

 
 
 



 
 
 

Document Prepared by Ian Tyrer-Tomkinson  Page 26 of 84 

Creating a Scan Tree Window 
A scan tree window may be created for any Mass Spectrometer on the system by using the 
Menu Bar, File, New or Open commands, or as previously shown by using the Gallery. 
 

 
 

 
Scan Tree Window Items: 
  

 Title bar  
The title bar shows the name of the mass spectrometer controlled by the scan tree, its status 
and the current file. In the picture above the mass spectrometer is called HAL V RC PIC-
RGA 301 #10697. 
The current file is C:\data files\hiden analytical\massoft\file4.exp.  All this information may 
not be visible due to the size of the scan tree window. 
 

 Shutdown box 
The Shutdown environment box holds the environment settings for Shutdown mode 
(normally set to reduce or turn off the source emission, turn off the SEM detector supplies, 
etc.). These values may be adjusted by double-clicking on the Shutdown box, which opens 
the Environment Editor dialogue box. 
 

 Events box 
The Events box provides access to the Event Editor.  Double-click on this box to display the 
Event Editor window. 
 
Note: 
The Events box is only present on instruments which support trips. 
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Scan Tree Components 
The Scan Tree consists of a Global box, a Scan box (with its input device) and a Stop box. 
 
 

 
 
The variable values used for File, New are based on those set up when the mass 
spectrometer was last used. 
 
Scan sequences start at the Global box and end at the Stop box. 
 

 

 Global box 
The Global box contains all the Global environment variables.  The global environment 
encompasses the variable values for all the acquisition modes, in this case RGA mode. The 
global environment for each acquisition mode contains the current variable values for that 
mode. These variable values are used whenever that acquisition mode is selected for a 
scan, unless overridden by a local environment associated with that particular scan. 
 

 The variable values for each type of acquisition mode can be edited double-clicking 
on the Global box, which opens the global Environment Editor dialogue box. 

 

 Scan box 
Double-clicking on a Scan box opens the Scan editor dialogue box for that scan. 
 
The Scan 1: mass box contains a description of a simple scan where the mass variable is 
varied, with all other environment variables held at the values contained in the Global box. 
During the scan, data is read from the device described in the Input device box. 
 
Further scans may be added to form a scan tree, with individual scans acquiring data from 
differing input devices, if required. Each scan in the tree uses the environment variable 
values set in the Global box, unless a local environment is added to it. 
 
Each scan in the tree also uses the default global environment acquisition mode, set in the 
Global box, unless its acquisition mode is changed by using the Scan Editor dialogue box.  
This allows multi-mode scanning, where different scans in the tree can operate in different 
acquisition modes (e.g. RGA, negative ion RGA, positive ion SIMS, negative ion SIMS). 
 
Different scan types (e.g. Histogram, Multiple Ion Detection, Profile) during one acquisition 
cycle can also be set up by using the Scan Editor dialogue box. 
 

 Input device box 
Double-clicking on the Input device box opens the Input Selection dialogue box; this allows 
selection of the input device used by a scan, if the mass spectrometer supports more than 
one input device. 
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Note: 
Only one input device may be selected for each simple, co-variant or multi-variant scan 
Group 
 

 Stop box 
The scan sequence ends at the Stop box which describes whether the experiment is to be 
repeated, for how many times, etc. Double-clicking on this box opens the Scan structure 
cycles dialogue box 
 

Editing a scan: the Scan Editor dialogue box 
Double-clicking on a Scan box opens the Scan Editor dialogue box for that scan. 
 
Note: 
The contents of the Scan Editor dialogue box list boxes depend on the configuration and 
capabilities of the associated mass spectrometer. 
 
Scan mode When the Scan Editor dialogue box is first opened, the Scan mode list box 
shows, by default, the instrument mode Global (XXX), where XXX is the acquisition mode 
selected in the global Environment Editor dialogue box, Instrument mode list box, in this 
case RGA mode. 
 
Scan legend Allows the scan legend name on views to be edited; the required name is 
typed into this box; up to 32 characters (including spaces) may be used. This name also 
appears on the Scan box. The scan legend defaults to the contents of the Available to Scan: 
box. 
 
Start value The scan start value for the variable selected in the Available to Scan: list 
box. This must be within the Minimum Value and Maximum Value range for the variable. 
 
Stop value The scan stop value for the variable selected in the Available to Scan: list 
box. This must be within the Minimum Value and Maximum Value range for the variable. 
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Note: 
This picture shows all the available options; the legends for Increment value, Steps, Relative 
Sensitivity and Relative SEM are grayed when these options are inapplicable or inactive. 
 
Increment value Defines the increment value for the scan; this cannot be less than 

Minimum Increment. 
 

If an Increment value of one is used with an integer Stop value and 
Start value, and the Stop value is greater than the Start value, a BAR-
type scan is performed which displays as a spectral histogram. Where 
an Increment value less than one are used, a PROFILE-type scan is 
performed which displays as an analogue graph. 

Steps The total number of steps during the scan, for the defined Start value, 
Stop value and Increment is calculated and displayed in this box. 
However, if a value is entered in this text box, the Increment value is 
adjusted to suit. 

 
Relative   
Sensitivity This is only active when the Start value is equal to the Stop value with 

mass as the scanned variable, i.e. a single ion scan. 
 

Relative Sensitivity is a measure of the probability of ionizing a 
molecule; the acquired intensity is divided by this value to give the 
reported value. The value for a particular ionizing mode and parent 
molecule can be obtained from the appropriate library and, if the Scan 
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Gallery is used to set up an MID scan, the correct value is 
automatically inserted. 

 
The real intensity = (acquired intensity)/(relative sensitivity). 

 
Relative SEM This is only active when the Start value is equal to the Stop value with 

mass as the scanned variable, i.e. a single ion scan. 
 

Relative SEM is similar to Relative Sensitivity; it is a divider which can 
be used to compensate for the inherent discrimination of the SEM 
detector. No standard values exist for this variable and a suitable 
value must be obtained by experiment. If a suitable value is not 
known, Relative SEM should be set to 1.00. 

 
Available to Scan: This list box defines the variable to be scanned; the limits and 

resolution values for the variable are displayed in the area below the 
list box. 

 
The variables that are available for scanning depend on the type of 
instrument and the selected Instrument mode. 

 
Variables that are not present in the Available to Scan: list but 
areavailable for scanning may be scanned by typing their name into 
the box. 

 
The mass used may be set in the Global box or the scan’s local 
environment. 

 
If energy is scanned, an Ion Energy Distribution, or a map of the effect 
of this variable on the analyser performance for tuning, may be 
obtained. 

 
Minimum Value Shows the minimum allowable value for the variable to be scanned; 

this cannot be edited. 
 
Maximum Value Shows the maximum allowable value for the variable to be scanned; 

this cannot be edited. 
 
Minimum 
Increment Shows the minimum allowable Increment value for the variable to be 

scanned; this cannot be edited. 
 
Description  Gives a brief description of the function of the current variable. 
 
 

 Opens the Scan advanced dialogue box which controls the way scans 
interact with the system; it may also be used to perform automatic 
tuning and mass alignment. 
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Scan Editor: Bar Tab 
The Bar tab creates a scan which takes a measurement at all integer values from the Start 
value to the Stop value.  

Typically this type of scan is used to survey a range of masses to identify which masses are 
present. 

 

 

Scan Legend Allows the scan legend name on views to be edited; the required 
name is typed into this box; up to 32 characters (including spaces) 
may be used. This name also appears on the Scan box. The scan 
legend defaults to the contents of the Available to Scan: box. 

 
Start Value The scan start value for the variable selected in the Available to Scan: 

list box. This must be within the Minimum Value and Maximum Value 
range for the variable. 

 
Stop Value The scan stop value for the variable selected in the Available to Scan: 

list box. This must be within the Minimum Value and Maximum Value 
range for the variable. 

 
Increment Value Defines the increment value for the scan.  For a Bar scan this is 1 and 

cannot be edited. 
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Steps Defines the total number of steps during the scan, for the defined Start 
value, Stop value and Increment value this is calculated and displayed 
in this box.  This cannot be edited as it is a Bar scan, and the 
Increment Value is fixed at 1. 

 
Relative Sensitivity This is only available for MID scans. 
 
Relative SEM  This is only available for MID scans. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 
 
 

Document Prepared by Ian Tyrer-Tomkinson  Page 33 of 84 

Scan Editor: Profile Tab 
The Profile tab creates a scan which takes a measurement beginning at the Start value, 
increasing by the Increment value until it reaches the Stop value.  This tab may be used to 
create scans other than Profile scans, for example it can be used to scan the Electron 
Energy to plot the appearance potential curve. 

 

 

Scan Legend Allows the scan legend name on views to be edited; the required 
name is typed into this box; up to 32 characters (including spaces) 
may be used. This name also appears on the Scan box. The scan 
legend defaults to the contents of the Available to Scan: box. 

 
Start Value The scan start value for the variable selected in the Available to Scan: 

list box. This must be within the Minimum Value and Maximum Value 
range for the variable. 

 
Stop Value The scan stop value for the variable selected in the Available to Scan: 

list box. This must be within the Minimum Value and Maximum Value 
range for the variable. 

 
Increment Value Defines the increment value for the scan.  This cannot be less than 

the Minimum Increment. 
Where an Increment value less than 1 is used a Profile scan is 
performed which displays an analogue output. 
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Steps The total number of steps during the scan, for the defined Start value, 
Stop value and Increment value this is calculated and displayed in this 
box.  If a value is entered in this box the Increment Value is adjusted 
to suit. 

 
Relative Sensitivity This is only available for MID scans. 
 
Relative SEM  This is only available for MID scans 
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Scan Editor: MIDTab 
The MID tab creates a scan which takes a single measurement at the mass specified by the 
Start value setting.  The default view created is a trend view of mass against time. 

Typically this type of scan is used to create a scan tree which measures one or more 
masses and monitors the changes against time. 

 

 

 

Scan Legend Allows the scan legend name on views to be edited; the required 
name is typed into this box; up to 32 characters (including spaces) 
may be used. This name also appears on the Scan box. The scan 
legend defaults to the contents of the Available to Scan: box. 

 
Start Value The scan start value for the variable selected in the Available to Scan: 

list box. This must be within the Minimum Value and Maximum Value 
range for the variable. 

 
Note 

Stop Value, Increment Value and Step are not applicable to MID scans so therefore are 
grayed out in the MID tab. 
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Library Button  The Library button is available in the Start value and Stop value list 
boxes if on the User Settings tab of the Preferences box.  This is 
opened by selecting Preferences in the Edit menu.  The Component 
library radio button has to be selected. 
Selecting the Library button displays a drop down list box which 
contains all the known components from the Library.  Selecting a 
component will result in a Mass Selection box being displayed, which 
will detail the relevant Mass Isotopes/Fragments for the component 
selected. 

 
 
Relative Sensitivity Relative Sensitivity is a measure of the probability of ionizing a 

molecule; the acquired intensity is divided by this value to give the 
reported value.  The value for a particular ionizing mode and parent 
molecule can be obtained from the appropriate library and, if the Scan 
Gallery or Library button is used to set up the MID scan, the correct 
value is inserted automatically. 

 
Relative SEM Relative SEM is similar to Relative Sensitivity; it is a divider which can 

be used to compensate for the inherent discrimination of the SEM 
detector.  No standard values exist for this, so a suitable value must 
be obtained by experiment.  If a suitable value is not known, Relative 
SEM should be set to 1.00. 

 

Input Selection dialogue box 
Double-clicking on the Input device box opens the Input Selection dialogue box.   If the mass 
spectrometer supports more than one input device, the Input Selection dialogue box allows 
selection of the input device used by a scan. 
 
Note: 
Only one input device may be specified for each simple, co-variant or multi-variant scan 
group. 
 



 
 
 

Document Prepared by Ian Tyrer-Tomkinson  Page 37 of 84 

 
 

The dialogue box supports range-switched input devices and allows the user to specify 
upper and lower auto-range limits to prevent auto-ranging to slower, high-gain ranges when 
very small peaks are not of interest, or to low-gain ranges which would suppress very small 
peaks. 
 
Available Inputs The Available inputs combination box contains a list of the input 

devices available on the instrument.  The input device may be 
selected by selecting the required name or by typing the name in the 
box. 

 
 
The input devices are as follows: 
 
SEM Secondary electron multiplier; the gain of the SEM is controlled by the 

multiplier voltage setting in the scan’s environment and the1st dynode 
voltage (if fitted). 

 
This detector is standard on pulse-counting instruments and optional 
on analogue instruments. 

 
Raw counts This is an alternative to the SEM on pulse-counting instruments; it 

reports the intensity as counts instead of counts/second. 
 
Faraday  Faraday cup detector. 
 

This detector is standard on analogue instruments. 
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Total Pressure The total pressure input device configures the analyzer to pass ions of 
all masses, thus giving an approximation of the total pressure in the 
system. The ions are collected by the Faraday detector. The mass 
selected is irrelevant when this input device is used. 

 
   This detector is only available on analogue instruments. 
 
auxiliary1 
auxiliary2 These are analogue inputs which can be read as a scan’s input; each 

input has user-selectable ±10 V and ±1 V ranges. 
 

The ranges are to the power 10, i.e., range 0 represents a x1 gain 
(10x100 full scale, ±10 V) and range -1 represents a x10 gain  

 (10x10-1 full scale, ±1 V). 
 

These detectors are standard on all instruments. 
 
Note: 
The names and ranges of auxiliary1 and auxiliary2 may be configured by the user, see 
Appendix E. 
 
f(x) This input device allows an input value to be calculated as a function 

of data previously acquired, or of another data value. 
Please contact Hiden Analytical Limited if further information is 
required. 

 
This detector is standard on all instruments. 

 

 
 
 
Acquisition range frame 
 
Note: 
The units displayed in the Acquisition range frame depend on the input selected. 
 
Start x10E This combination box contains the range used at the start of a scan. 

The value entered is a power of ten; i.e. if 7 is entered; the range set 
is 10-7 Torr. 

 
For instruments with a pulse counting detector Start specifies the 
maximum number of count counted, it should normally be left ser to 7 
(107 counts) 

 
Auto range When selected, this allows the analyzer to automatically change the 

range and follow changes in the input signal. 
  

The manner in which automatic ranging is applied can be controlled 
by the user. 

 
Highest x10E This combination box contains the highest range to which the input 

device may autorange; the entered value is a power of ten. Highest 
x10E is not applicable to pulse-counting instruments. 



 
 
 

Document Prepared by Ian Tyrer-Tomkinson  Page 39 of 84 

Note: 
The Highest x10E value should be set to the expected maximum intensity, i.e. the 
pressure in the vacuum system as indicated by the vacuum gauge. 
 
Lowest x10E This combination box contains the lowest range to which the input 

device may autorange; the entered value is a power of ten. Lowest 
x10E is not applicable to pulse-counting instruments. 

 

Other controls 
 
Dwell Time Defines the time used to acquire a single point in the scan. A value 

may be typed directly into the text box. 
 

If the radio button marked mS is selected, the value in the text box will 
be specified as milliseconds. The value automatically appearing in the 
text box when the Input Selection dialogue box is opened can be set 
by an entry in the HIDEN.INI file. 

 
If the % radio button is selected, the value will be interpreted as a 
percentage of the default dwell time for that range. The default dwell 
time for a given system and range is contained within look-up tables in 
the MSIU’s microcomputer; it is selected to give a good signal-to-noise 
ratio for the selected range. 

 
Settle Time Defines the time to allow the electronics to settle before the scan is 

started. A value may be typed directly into the text box. 
 

If the radio button marked mS is selected, the value in the text box will 
be specified as milliseconds. The value automatically appearing in the 
text box when the Input Selection dialogue box is opened can be set 
by an entry in the HIDEN.INI file. 

 
If the % radio button is selected, the value will be interpreted as a 
percentage of the default settle time for that range. The default settle 
time for a given system and range is contained within look-up tables in 
the MSIU’s microcomputer; it is selected to allow adequate settling on 
the selected range. 

 
When the scan has started, a point time is applied between each 
measurement; this time cannot be defined by the user. There are also 
other delays which contribute to the overall scan time. 

 
Auto Zero When selected, this forces the analyzer to perform an automatic 

zeroing function at the start of each scan. This corrects any errors due 
to amplifier offsets and leakage currents. 

 
 
Note: 
For the SEM input on pulse-counting instruments, the Auto Zero and Auto range (and hence 
Highest x10E and Lowest x10E) entries are not applicable; Acquisition range, 
Start sets the maximum expected count rate which affects the Settle time and Dwell time 
 when they use the percentage mode. 
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Simple scan Creation 
 

 
 

A simple scan is added to the basic scan tree (above) by selecting (clicking) a Scan box and 

then selecting the Tool Bar Next scan tool,  ; the focus is set to the new scan in the 
scan tree. 

 

 
 

A simple scan sets the output variable (in this case mass) to the Start value (as entered in 
the Scan Editor dialogue box) and reads the input variable (in this case the Faraday). It then 
steps the output variable by the Increment value and reads the input again. This is repeated 
until the Stop value is reached. 
 
Each scan is given a scan number to allow it to be associated with its attached view(s). 
Only scans with input devices may have views attached, but several views may be attached 
to one scan so that the data may be presented in different ways. 
 
Any type of scan may have a local environment added by selecting the Scan box and then 

selecting the Attach local environment button (on the Scan Setup tool bar), . The 
presence of a local environment is shown by a local Set box attached to the scan. 

 

 
 

Double-clicking the local Set box opens the local Environment Editor dialogue box, which 
allows the local environment variables to be defined. 
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Co-variant scan 
A co-variant scan is created by selecting the appropriate Scan box and then selecting the 

Co-variant scan button (on the Scan Setup tool bar), ; the Co-variant scan is added to 
the selected scan and the focus is set to the new scan. 

 

 
 

A co-variant scan sets the output variable in Scan 1 (in this case electron energy) to its Start 
value; sets the output variable in Scan 2 (in this case mass) to its Start value and then reads 
the input device (in this case the Faraday). It then steps each output variable by its 
Increment value and reads the input again (only the bottom scan of the structure allows the 
Increment to be set; this determines the number of steps for all the scans). This is repeated 
until both Stop values are reached. If one scan requires fewer steps than the other to reach 
its Stop value it repeats the measurement at its Stop value; the Stop value is not exceeded. 
 
As many output devices as required can be scanned in step together. 
 
Note: 
The co-variant scan has several Scan boxes but only one input device, attached to the scan 
containing the last output device set. This is because the input is only read when all the 
outputs have been set. 
 

Multi-variant scan 
A multi-variant scan is created by selecting the appropriate Scan box and then selecting the 

Tool Bar Multi-variant scan button (on the Scan Setup tool bar), . The new scan will be 
added to the scan tree and will have the focus. 

 

 
 

A multi-variant scan sets the output variable in Scan 1 (in this case electron energy) to its 
Start value and then performs Scan 2. Scan 2 sets its output variable (in this case mass) to 
its Start value, reads the input variable (in this case the Faraday) and then steps the output 
variable by its Increment value and repeats the read, continuing this cycle until its Stop value 
is reached. Scan 1 then steps its output variable (energy) by its Increment value and 
performs Scan 2 again, repeating this until its Stop value is reached. 
 
Multi-variant scans can be nested to any depth required, limited only by the memory required 
to store multi-variant data in the Mass Spectrometer Interface Unit. If Scan 1 and Scan 2 
both have 100 steps this requires the storage of 10,000 data points. Adding another nesting 
level would increase this to 1 million data points - nesting scans rapidly uses memory. 
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Note: 
A multi-variant scan can have several levels of hierarchy but only one input device, which is 
always attached to the lowest scan in the hierarchy to indicate that the input is only read 
after the last scan’s output variable is set. 
 

Repeating scans 
The scan sequence ends at the Stop box; double-clicking on this box opens the Scan 
structure cycles dialogue box. 

 

 
 

Continuous 
Scanning When this box is selected, the scan tree is executed continuously until 

stopped by the user. 
 
Cycles The number of cycles for which the scan tree is to be executed is 

entered in this box; the box is grayed if the Continuous scanning box 
is selected. 

 
When the scan is set to scan continuously, or when the number of cycles is greater than 
one, the scan tree is shown with a line from the Stop box (which now shows the word 
Repeated) back to the start. 

 

 
 

Minimum cycle 
time The time between execution of scan tree cycles can be entered in 

hours:min:sec. Multiple cycles repeat as fast as possible if this value is 
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set to zero (default), but, if a value is entered which is longer than the 
time required to complete one cycle of the scan tree, scanning pauses 
until the set time has expired before a new cycle is started. 

 
Retain Mass   
Alignment This box is normally grayed out.  However, if mass alignment has 

already been selected, by using the Menu Bar, System, Maintenance, 
Auto mass align command the box will be ticked and, at the 
completion of scanning, the mass alignment information will be 
returned to the PC and stored on disk.  This alignment information will 
be used until the mass table is cleared, or another Auto mass align is 
performed. 

Retain Autotune 
Values This box is normally grayed out.  However, if autotuning has already 

been selected, by using the Scan Editor box Scan advanced button, 
the box will be ticked and the tuned variable values will be stored in 
the scan tree Global environment at the completion of scanning.  They 
can then be stored in the experiment file and recalled or imported into 
a local environment later. 

 
Shutdown after 
Scanning Selecting this option loads the variables from the Shutdown 

environment box into the mass spectrometer when scanning is 
stopped. This allows, for example, lower or zero ion source filament 
emission to be set and the SEM detector EHT voltages to be reduced, 
or turned off, when the instrument is not in use. 

 
If this option is not selected, the variables are left in the state they 
were in when scanning was stopped. 

 
Export after 
Scanning Selecting this option causes data to be exported at the end of each 

scan.  The file format is defined in Preferences, User Setting.  Data is 
exported from the first view attached to the scan tree. 

 
 
 
 
Automatic scan 
Restart When this option is selected, MASsoft immediately tries to restart any 

scan stopped by a trip or events sequence.  This option is intended for 
use with process automation controlled by events sequences. 

 
No data retrieval This option stops MASsoft retrieving data from the MSIU to the PC 

when scanning, thus speeding up data acquisition.  This function is 
identical to the Menu Bar, System, Maintenance, Stop data retrieval 
command. 
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Copy and paste 
One part of a scan tree may be copied to another using the Copy and Paste commands. 
Items are copied to the clipboard in both MASsoft and Text formats which allows Scans, 
Environments and Trips to be pasted in to other applications such as Word Processors. If 
multiple items are selected only the first one will be copied. 
 
The paste command copies values from the clipboard into all selected items. It does not 
create new scans just copies values from one scan to another. If an environment is pasted 
into a scan without a Local Environment one will automatically be created. 
To copy and paste: 
 

1. Select the item to be copied. 
 

2. Right click. A pop-up menu will be opened. 
 

3. Select Copy. The item is copied to the clipboard. 
 

4. Position the cursor where the item is to be pasted. 
 

5. Right click and select Paste from the pop-up menu. 
 
Note 
1. If a Scan is copied then both the Scan and the Input settings will be copied. If the Input 
settings are copied then the Scan will not be copied. 
2. When a scan with sub-ordinate multi-variant scans is copied the sub-ordinate scans are 
also copied. 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 
 
 

Document Prepared by Ian Tyrer-Tomkinson  Page 45 of 84 

Global Environments 
The global environment encompasses the variable values of all the acquisition modes. 
The global environment for each acquisition mode contains the current device values for that 
mode. These device values are used whenever that acquisition mode is selected for a scan, 
unless overridden by a local environment associated with that particular scan. 
 
The device values for each type of acquisition mode can be edited using the Global 
Environment Editor. 
The acquisition mode of all the scans using the global mode can be changed by selecting 
the required mode in the Global Environment Editor dialog box. 
 
 
The Global Environment is stored in the Experiment file. 
 
 
Scan Global Environment Editor 
The Global box holds the global environment values for all modes and defines which 
acquisition mode is used when the global mode is selected in the scan. The environment 
values may be edited by double-clicking on the Global box, which opens the global 
Environment Editor box. 
 

 
 
 

Group Values may be grouped by function.  Each group contains devices 
with a related function.  This column cannot be edited. 

 
Use Determines whether the values used should be taken from this 

dialogue if selected () or from a lower level in the environment 
hierarchy: the Instrument Environment. 
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Name   The name of the device which, cannot be edited. 
 
Value Shows the current value of the selected variable.  If the use column is 

selected () the Global Environment value will be displayed.  If the 
use column is not selected the Instrument value will be displayed.  
The value may be edited. 

 
As soon as the value is edited the Use column is selected ().  It is 
always the Global value which is changed. 

 
Units   The units of the value.  This cannot be edited. 
 
Additional Information 
Additional information relating to the currently selected device is shown in the right hand 
panel. 
 
Minimum The minimum permissible value for the currently selected device.  This 

cannot be edited. 
 
Maximum The maximum permissible value for the currently selected device.  

This cannot be edited. 
 
Resolution The minimum permissible increment value for the currently selected 

device.  This cannot be edited. 
 
Description  A brief description of the currently selected device. 
 
 

Default mode The default mode button, , is shown as being selected 
() in its tab. The color of the default mode button reflects the color of 
the default mode’s tab. 

  
To change the default mode select the tab of the required mode and 
click on the Default mode button. 

  
Changing the default mode changes the mode of all scans whose 
mode is designated Global (XXX), where XXX represents a mode. 

 

Filaments The filament buttons, , in this case filament F2, show the 
state of the filaments in the environment and allow them to be turned 
on or off by selecting the appropriate button. A filament is shown red 
when it is active, or switched on and blue when it is switched off. 
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Note: 
These buttons show the filament state set in the currently selected environment; they do not 
necessarily show the state of the actual filaments in the probe ion source. This is because, 
during scanning, the actual filament is set to what is selected in the environment being used 
in the current scan. The true state of the filaments can be seen on the Status Bar. When the 
system is shut-down, the true filament state may also be seen by selecting the Shutdown 
environment box where the buttons reflect the state of the probe filaments. 
 

Calibrate The Calibrate button, , displays the Device calibration 
box.  This allows the actual output of the device to be adjusted for 
better correspondence with the device value. 

 

Cancel The cancel button, , is displayed when the instrument is 
scanning.  When the instrument is not scanning the Cancel returns the 
values in place when the Global Environment Editor was opened. 
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Shutdown Environment 
 
CAUTION 
Ensure that the filaments are not inadvertently turned on in the Shutdown mode. 
When the Shutdown environment editor is selected, the Filament buttons reflect the state the 
filaments would have if the instrument was in the Shutdown state, not the current state of the 
filaments. If a filament is selected in the Shutdown environment editor, when the instrument 
next switches to the Shutdown state (at the end of a scan), the filament will be on. 
 
The Shutdown environment contains a set of device values that are appropriate for the 
instrument when it is not in use. For example, when not in use for short periods, it makes 
sense to keep the instrument powered-up but to switch off the filaments; this saves energy 
and prolongs the equipment life. 
 
The device values for the Shutdown Environment are edited in the Shutdown 
Environment Editor box. 
 
The Shutdown Environment is stored in the Experiment file. 
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Views 
A view is a window that contains a display of data from one or more scans. The data may be 
displayed in the form of a graph (graphical view) or a table (tabular view). Data may be 
viewed during acquisition, or existing data, held in experiment files, may be viewed. 
 
The presentation of the data in a view may be customised; multiple views of the same scan 
allow the data to be presented in different formats simultaneously. 
 

Graphical views can be easily created by using the Attach view button, . 
 
The menu bar Views menu allows graphical and tabular views to be created, destroyed and 
customised. 
 

 
 

 
Above shows a scan tree with both scans selected, in this case both are MID scans this is 
achieved by selecting each scan in turn with the Ctrl button on the keyboard being held 

down. Selecting the Attach view button, , will result in one view being opened, which 
displays both mass 18 and mass 28 on the same graph, as per below. 
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Background Subtract 
 
The Menu Bar Views, Background subtract function subtracts the data values in one view 
(the “source” view) from the data values in a selected “target view”, with the result being 
displayed in the “target” view. An operations window, describing the operation that has been 
performed, is displayed by default in the target view. 
 
Background Subtract works on both graphical and tabular views; the views can be from 
different data files. 
 
Note: 
It may be found useful to tile the views (using the Menu Bar Window, Tile vertical or Window, 
Tile horizontal command) before using Background subtract. 

 
To use Background subtract: 
 

1 Select the view which contains the data values that are to be subtracted from the 
data values in the “target” view. 

 
2 Select Source view in the Views menu. 

The selected view becomes the “source” view. 
 
If the “source” view consists of graphical MID data, the MID Data source box will open. 
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This prompts the user to enter the cycle containing the data which is to be subtracted, as a 
constant, from the “target” data.  Select the required cycle and press the OK button before 
continuing. 
 
If the “source” is a tabular view, the MID Tabular data source box is opened.  This box allows 
the user to select the cycle or statistical data to be subtracted from the “target” view. 
 

 
 
 

3 Select the view which is to be the “target” view 
 

4 Select Background subtract in the Views menu. 
 
The “source” data is subtracted from the “target” data and the result is displayed in the 
“target result” view. 
 
An operations window is displayed, by default, in the “target result” view.  This gives brief 
details of the Background subtract operation(s) used to create the view. 
 
Note: 
It is possible to subtract several different “sources” from one “target”, hence the operations 
window can contain more than one operation. 
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Example of “target” view 
 
 
 

 
 

Example of “target result” view 
 

5 If required, the operations window can be turned off by selecting Show operations 
in the Views menu. 

 
The operations window can be turned back on by selecting Show operations in the Views 
menu 
 

6 A “source” view can be deleted from the operations list by selecting it and then 

pressing the Delete button, . 
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Exporting Data 
Data may be exported in various formats for use in other applications. 
 
Windows screen copy 
A bitmap copy of all or part of the MASsoft application screen can be made using the normal 
Windows copy options. To copy an active MASsoft application window, press the Alt, Print 
Screen key combination. To copy the whole screen, where MASsoft is not maximised, press 
the Print Screen key. With either method, the resultant bitmap may be copied into other 
Windows applications by pasting from the clipboard. 
 
Exporting ASCII and DDE data, and copying to the clipboard 
Data may be exported for use in other graphics packages and spreadsheets by clicking 
Export on the File menu which provides two export options: 
 

 File enables the current data to be exported as an ASCII file for use by other 
packages. 

 DDE provides the ability to transfer, in real time, data to other Dynamic Data 
Exchange (DDE) client-compatible applications by defining the relevant data and 
then using Edit, Copy to copy the data to the clipboard. 

 
ASCII file format 
When File, Export, File is selected, the Export Information dialog box is opened, which 
requests an output file name. 
 

 
 
When a name has been entered in the File Name box, clicking the OK button produces a file 
of ASCII values separated by the default Windows separator character for the view currently 
selected. For a normal sequence or co-variant scan, the whole of the scan is exported, but 
when a multi-variant scan is selected, the whole of the major (i.e. highest level) scan is 
output, which may include several subordinate scans, resulting in a large output file. The 
.csv extension name allows the resultant file to be read into other applications as ASCII 
comma-separated values, after which the data can be manipulated as required. 
 
Refer to the Windows Control Panel documentation for details of the Separator character 
and International settings. 
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Note 
In Windows XP the separator character can be checked/edited by: 
Double clicking Regional and Language Options on the Control Panel, selecting the 
Regional Options tab, clicking the Customize... button which opens the Regional 
Options dialog box. The 
 
CAUTION 
Changing the Separator character may cause MASsoft and other Windows applications to 
function incorrectly. 
 
DDE and copying to the clipboard 
Selecting Export, DDE on the File menu opens the DDE link selection box. 
 

 
 

 
The type of information to be linked is selected by clicking on it, then clicking the OK button. 
To transfer information, select the view containing the scan to be copied or linked then click 
Copy in the Edit menu to transfer the information to the clipboard. The client application can 
then import the data using the Edit, Paste command, or link to it, using the Edit, Paste 
Special command. 
 
Note: 
When a view is copied to the clipboard, using the Edit, Copy command, two sets of data are 
transferred. One set is text data, which allows DDE values to be transferred, the other is the 
view as a Windows metafile picture. If the Edit, Paste command is used when pasting the 
data into another application, the client application will take the most suitable data set for its 
normal operation. For example, a word processor will take the text, whereas a drawing 
application will take the picture. 
 
To force the client application to take the other data set (for example, a picture into a word 
processor) the Edit, Paste Special command must be used; this allows the input object to be 
selected. If the Paste: option in the Paste Special dialog box is selected, the data is copied 
into the client application and the transfer ends. If the Paste Link: option in the Paste Special 
dialog box is selected, a link is set up between the client and the MASsoft server. If the data 
in the MASsoft view now changes (e.g. during acquisition) the new data will automatically be 
transferred to the client. This “hot link” can be used with a spreadsheet, for example, to 
extend MASsoft’s data-processing capabilities. 
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The Options... button is only available if the selected information is Data and the view is a 
Multiple Ion Detection (MID)-type. Selecting this button opens the MID data dialog box, 
which allows the Number of cycles and Time Formats to be selected, each individual time 
format, or both time formats, can be selected. 
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Icons 
 
MASsoft Version 7 Professional features new toolbar icons in addition to the original icons 
used in previous releases of the MASsoft application. The new and original icons are 
described below. 
 

  The Unlock button unlocks a file containing data to allow editing. 
The Unlock button has the same function as clicking Unlock on the File menu. 

 

  The Print button prints the currently selected view. The Print button on the 
Shortcut tool bar has the same function as clicking Print on the File menu. 

 

  The Print Preview button reviews data in print layout format before it is 
selected for printing. The Print Preview button on the Shortcut tool bar has the 
same function as clicking Print Preview on the File menu. 

 

  The New Co-variant scan button is used to add a new co-variant scan to a 
scan tree. The New Co-variant scan button performs the same function as 
clicking Insert new Co-variant on the Edit menu. 

 

  The New Multi-variant scan button is used to add a new multi-variant scan to 
a scan tree. The New Multi-variant scan button performs the same function as 
clicking Insert new Multi-variant on the Edit menu. 

 

  The New Scan button is used to add a new scan to a scan tree. The New 
Scan button performs the same function as clicking Insert new Sequence on 
the Edit menu. 

 

  The Attach local environment button is used to attach a local environment to a 
scan to allow the global environment values to be over-ridden for that scan, 
and enable it to be tuned individually.  For example, where maximum 
sensitivity is required in several different mass MID scans, the ion transport 
environment may be optimised locally for each mass.  This button performs 
the same function as clicking Set local environment on the Edit menu. 

 

  The Delete button may be used to delete scans or local environments. To 
delete an environment or a scan, first select the object by clicking on it, and 
then click the Delete button.  The Delete button performs the same function 
as clicking Delete on the Edit menu. 
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  The Attach view button attaches a graphical view to a scan. An appropriate 
view for the type of scan is automatically created, a trend display if the scan 
has a single mass, or a graph if a variable scans over a range. More than one 
view may be attached to a scan, allowing the data to be displayed in several 
different ways. The Attach view button performs the same function as clicking 
New Graph View on the Views menu. 

 

  The New Mid Tabular view button adds a new MID tabular view. Performs the 
same function as selecting New MID Tabular View on the Views menu. 

 

  The Shutdown button stops data acquisition (if running), and puts the system 
into the Shutdown state by loading the values in the Shutdown environment 
box into the mass spectrometer.  These would normally be set to remove any 
high voltages from the system [e.g. the detector High Tension (HT) and 1st-
dynode supplies] and turn the ion source filaments either off or to a low value, 
but leave the system ready for operation at short notice. A “V” in the icon 
indicates when the system is in the shutdown state. The Shutdown button 
performs the same function as clicking Shutdown on the System menu. 

 

  The PowerUp button puts the mass spectrometer into a powered-up (‘ready’) 
state using the instrument mode information and variable values specified in 
the Global environment box at the top of the scan tree. If this is labelled 
Global : RGA, for example, the system is set to RGA mode. A “V” in the icon 
indicates when the system is in the powered-up state. 

   
  This button does not start data acquisition.  
   

The Power Up button performs the same function as clicking Active on the 
System menu. 

 

  The Start button (green) starts data acquisition; the mass spectrometer will be 
powered-up if it is in the shutdown state. If any changes have been made to 
the scan tree since the last acquisition or scan set-up operation, the new 
values are downloaded to the mass spectrometer before acquisition starts. 

 

  The Stop button (amber) stops the scan at the end of the current cycle. When 
the end of the cycle is reached, this button is automatically deselected and 
the Abort button (red), is automatically selected. 

 

  The Abort button (red) stops the scan as quickly as possible without waiting 
for the end of the cycle. If the Shutdown after scanning check-box in the Stop 
box Scan structure cycles dialog box is selected, selecting this button is 
equivalent to using the Shutdown button. 
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  The Degas button allows either filament to be switched on at a high electron 
energy for a certain time period; this heats the filaments and ion source cage 
which cleans them through forced degassing. Scanning cannot be performed 
whilst degassing. 

 
 
Icon selection 
The type of toolbar icons can be selected in the Tool bar size frame of the Menu tab in the 
Preferences dialog box selected on the Views menu. 
 
 

 
 
 
The different icons are selected by clicking on the relevant radio button. The change is 
implemented immediately so the user can see the effect straight away. 

 

 

 

 

 

 



 
 
 

Document Prepared by Ian Tyrer-Tomkinson  Page 59 of 84 

Dwell and Settle Times Explained 

The Dwell % is determined by the range you are scanning on, and is at a predetermined setting 

for each range.  Therefore measuring 9x10-8 will have the same dwell as measuring 1x10-8, but 

if you measured on different ranges 0.9x10-7 (not 9x10-8) it will have a shorter dwell time, 

whereas 10x10-9 (not 1x10-8) would have a longer dwell time.  This is to reduce the Signal/Noise 

ratio for the more sensitive ranges. 

 

The Settle time is only used when the instrument switches mode i.e. switching between the SEM 

detector and the Faraday detector.  This is to prevent the voltage decay from being ‘picked up’ 

by the Faraday detector when switching from the SEM – it allows a time for the voltage to 

stabilize to 0V (Settle) before continuing the scan. 

 

The dwell time is the time duration the instrument ‘sits’ on a peak to allow for it to measure 

more accurately the actual peak intensity ‘factoring out’ the noise. 

 

If you are measuring multiple masses in MID mode, it first measures the base line (Auto Zero), 

starts the scan, ‘sits’ on the mass for a period (dwell) then displays the result on scan 

completion.  The next scan starts and if using the same detector as the previous mass, measures 

the base line (Auto Zero), starts the scan, ‘sits’ on the mass for a period (dwell) then displays the 

result on scan completion.  Then the next scan starts, if it is using a different detector than the 

previous mass it waits for a period for the electronics to stabilize (settle) then measures the base 

line (Auto Zero), starts the scan ’sits’ on the mass for a period (dwell) then displays the result on 

scan completion etc. 

 

If you are just using the one detector, either Faraday or SEM the preferred method is to have 

them masses in ascending mass order.  If you have an MID scan tree which combines both 

detectors the preferred method is to have all the Faraday detector measurements together and 

all the SEM detector measurements together, both in ascending mass order. 

It is also advisable to have the Mass setting in the Global RGA box set to the first mass in the 

scan tree.  
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Explanation of Global RGA Parameters 

Multiplier 
The voltage applied to the SEM detector; with a PIC this should be set so the 
SEM operates in the Plateau Region.  With an Analogue system this should 
be set to 1000 gain, i.e. a scan in Faraday should be equal height using the 
SEM detector. 
 

Resolution 
The high mass peak width/valley adjustment used during set up and 
maintenance. Can also affect the low masses and should be adjusted in 
conjunction with the Delta-M. 

 

Delta-M 
The low mass peak width/valley adjustment used during set up and 
maintenance.  Can also affect the high masses and should be adjusted in 
conjunction with the Resolution. 

 

Discriminator 
Used to reduce/increase the baseline threshold new systems should be set to 
10% by default. 

 

Emission 
The Emission current is the current which flows from the active filament to the 
Ion Source Cage.  An increase in Emission Current causes an increase in 
peak intensity, can be used to increase/reduce the peak intensities. 

 

Electron Energy 
  The Electron energy is used to define the filament potential in the Ion Source.   

This is used to change the Appearance Potential of gasses with similar mass 
footprints so they can be looked at individually. 

 

Cage 
This is the Ion Source Cage voltage which controls the Ion Energy.  The 
higher the Ion Energy the faster the Ions travel through the Mass Filter to the 
Detector, this reduces the oscillation effect caused by the RF which is applied 
to the filter. 

 

Focus 
This is the voltage applied to the Focus plate.  This is used to extract the 
positive Ions from the source and into the Mass Filter, and also to block the 
transmission of electrons. 

 

Mode Change Delay 
  This is not used in RC RGA Instruments. 
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Creating an MID and BAR Multi-Variant Scan 
 
Open a New Scan tree. 
Select the Scan 1: Mass box and select from the Toolbar Create a new multi-variant scan. 
 

 
Double click the Scan 1: Mass box to open the Scan Editor window.  In the Available to Scan drop 
down box select none.  In the Start Value select 1, in the Stop Value select number of actual MID 
scans you wish to perform before the BAR scan i.e. 3.  In the Increment Value select 1. 
  
To set up the MID scans select the Scan 2: Mass box and select from the toolbar Create a new scan 
to be performed in sequence and add as many scan boxes as required and set each Scan*: mass box 
up as required, one of which could be used to perform a Temperature scan using an Aux input. 
 

 
To set up the BAR scan select the Scan 1: none box and select from the toolbar Create a new scan to 
be performed in sequence to add a scan box.  This will be displayed as Scan 5:mass box, select this 
to open the Scan Editor window and set the BAR scan up as required. 
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To set up the views you will need to select the BAR scan the Scan 5: mass Box and select the 
Binocular Icon New Graph View from the toolbar.  For the MID views (including the Temperature if 
added) select all the MID scans Scan 2: mass box to Scan 3: mass box with using the Ctrl button and 
then select the Binocular Icon New Graph View from the toolbar so each mass (including 
Temperature if added) is displayed in one view. 
 

 
This creates an MID scan with all MID masses (including Temperature if added) in one view then a 
BAR scan in a separate view.  This allows you to monitor a number of MID masses (including 
Temperature if added) in this case 3 MID masses (Mass 4, 28 and 40) for a set number of cycles (3 
using the above settings) and the automatically perform a BAR scan.  This repeats through the whole 
scan tree again and again until stopped by the user. 
 
Please note!  
There will be ‘dead areas’ on the MID scan view where the BAR scan was performed. 
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Calculating Relative Sensitivity for Three Gasses 

To accurately quantify levels of gasses you must first calculate the Relative Sensitivities (RS) for all 

the gasses you are measuring.  The calibration of the Relative Sensitivities requires a gas mixture 

containing all the gasses you wish to measure in known quantities to be connected to the system.  

The mixture need to be then measured and, assuming the highest concentration gas has a Relative 

Sensitivity (RS) of 1, a factor is calculated, and then applied to the results to achieve the expected 

concentrations, as per the calibration gas. 

This method can be used as an example for the calculation of further gasses if required. 

 Calibration gas concentrations of the three gasses are as follows:- 

 Nitrogen at 85%, Oxygen at 9% and Argon at 6% 

The actual measurements on the Mass Spectrometer are as follows:- 

Nitrogen (N2) = 8.97x10
-6

 

Argon (Ar) = 6.0x10
-7

 

Oxygen (O2) = 4.3x10
-7

 

 The Total pressure is 8.97x10
-6

 + 6.0x10
-7

 + 4.3x10
-7

 = 10x10
-6

 (1x10
-5

) 

Therefore the mixtures present are:- 

N2 (85%) = Total Pressure (N2+Ar+O2) X 85% = 1.0x10
-5

 X 85% = 8.5x10
-6

 

Ar (9%) = Total Pressure (N2+Ar+O2) X 9% = 1.0x10
-5

 X 9% = 9.0x10
-7

 (0.9x10
-6

) 

O2 (6%) = Total Pressure (N2+Ar+O2) X 6% = 1.0x10
-5

 X 6% = 6.0x10
-7

 (0.6x10
-6

) 

Therefore 

Relative Sensitivity for N2 = 8.97x10
-6

 / 8.5x10
-6

 = 1.055 

Relative Sensitivity for Ar = 6.0x10
-7

 / 9.0x10
-7

 = 0.667 

Relative Sensitivity for O2 = 4.3x10
-7

 / 6.0x10
-7

 = 0.717 

Therefore  

Corrected for N2 Relative Sensitivity as 1.00 

Relative Sensitivity for N2 = 1.055 / 1.055 = 1.00 

Relative Sensitivity for Ar = 0.667 / 1.055 = 0.63 

Relative Sensitivity for O2 = 0.717 / 1.055 = 0.68 
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Calculating Relative Sensitivities for Overlapping Gasses 

When calculating Relative Sensitivities some gasses have overlaps with other masses for 

example Carbon Dioxide at mass 44 has a percentage contribution at mass 28 by 11.4%.  

Theses overlaps need to be considered when calculating for the Relative Sensitivities where 

overlaps occur.  The example below explains the calculations required for a mixture 

containing Nitrogen and Carbon Dioxide with the contributing overlap at mass 28 of 11.4% of 

the Carbon Dioxide at mass 44. 

For a gas mixture of N2 and CO2 

The mixture contains N2 at 90% and CO2 at 10% 

Mass 28 = 100% N2 + 11.4% of CO2 (due to mass overlap) 

Mass 44 = 100% CO2 

Pressures measured:- 

Mass 28 = 1.08x10-6 

Mass 44 = 1.28x10-7 

Therefore N2 pressure is:- 

Mass 28 – (11.4% of CO2)  = 1.08x10-6 – (1.28x10-7 X 11.4%) 

    = 1.08x10-6 – 0.146x10-7  

    = 1.0654x10-6 

Therefore; 

Total N2 = 1.0654x10-6 

Total CO2 = 1.28x10-7 

The Total N2 + CO2 (100%)  = 1.0654x10-6 + 1.28x10-7  

    = 1.193x10-6 

Therefore the mixture pressures are:- 

N2 (90%) = Total Pressure (N2 + CO2) X 90% = 1.193x10-6 X 90% = 1.0737x10-6 

CO2 (10%) = Total Pressure (N2 + CO2) X 10% = 1.193x10-6 X 10% = 1.193x10-7 

Therfore 

Relative Sensitivity for CO2 = 1.28x10-7 / 1.193x10-7 = 1.073 

Relative Sensitivity for N2 = 1.0654x10-6 / 1.0737x10-6 = 0.992 

Assuming you want the RS of N2 as 1.00 then CO2 = 1.073 / 0.992 = 1.082 
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Warnings and Recommendations 

 
Mass Spectrometer Over-Pressure Protection 
 
CAUTION! 
Operation of the Mass Spectrometer at pressures exceeding those specified below 
may damage both filaments and, more critically, from a cost/downtime viewpoint, the 
detector. 
 
The recommended maximum operating pressures are as follows: 
 
Filament: 1 x 10-4

 Torr 
 
Faraday detector: 1 x 10-4

 Torr  
 
SCEM detector: 5 x 10-6

 Torr 
 
Channelplate SEM detector: 1 x 10-6

 Torr 
 
The gauging provided on the vacuum system has been used to protect the system via the IU 
over pressure protection trip input. 
 
 

System Protection 

 
The system contains an internal over pressure detector in the ion source; this can only 
operate when one, or both, of the probe filaments are switched on. This detector offers 
system protection in the event of a pressure rise during operation, but it is still possible to 
switch a filament on under high pressure conditions and so damage it. For maximum 
protection, it is recommended that an external pressure gauge, such as an ion or Penning 
Gauge, is linked to the IU inhibit input. 
 
The IU has a circuit which senses the IU inhibit input situated on the TRIPS 05 connector, at 
the rear of the IU. This input must be at logic 0 level, or linked to 0V, in order to be able to 
turn on the mass spectrometer filament and SEM detector high voltage. This can be 
protected by the trip contacts of a Penning Gauge. 
 
Where the basic unit is supplied without a vacuum system, a link is provided by a 15-pin D-
connector, with pins 12 and 13 shorted together. 
 
If a vacuum system has been supplied by Hiden Analytical Limited, the mass spectrometer 
inhibit input is connected to relay contacts on the vacuum pump controller or on a total 
pressure gauge such as a Penning or hot-filament ionization gauge with appropriate trip 
levels set. 
 
 
Note: 
The over-pressure trip is not user-definable; it trips only if the inhibit input circuit has tripped, 
or the ion source pressure is too high and a filament is switched on. 
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Filament operation at reduced electron energy 
 
CAUTION! 
Using too high an emission value may damage the filament. 
 
Electron Energy can be set to a minimum value of 6eV. When Electron Energy is to be 
scanned from less than 20eV, the emission current must be reduced in order to protect the 
filaments from damage due to excessive current demands. 
Please refer to the RC RGA Operator’s Manual for recommended operation. 
 
For an emission current of 400mA, the demanded filament current changes slowly, with 
decreasing electron energy until the electron energy is approximately 18eV. A rapid increase 
in demanded filament current then occurs due to changes in the emission characteristics. 
Running the filaments in this region may lead to filament damage. The onset of this region 
occurs at lower electron energy values as the emission current is decreased. 
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Shutdown environment 
 
CAUTION 
Ensure that the filaments are not inadvertently turned on in the Shutdown mode. 
When the Shutdown environment editor is selected, the Filament buttons reflect the state the 
filaments would have if the instrument was in the Shutdown state, not the current state of the 
filaments. If a filament is selected in the Shutdown environment editor, when the instrument 
next switches to the Shutdown state (at the end of a scan), the filament will be on. 
 
The Shutdown environment contains a set of device values that are appropriate for the 
instrument when it is not in use. For example, when not in use for short periods, it makes 
sense to keep the instrument powered-up but to switch off the filaments; this saves energy 
and prolongs the equipment life. 
 
The device values for the Shutdown Environment are edited in the Shutdown 
Environment Editor box. 
 
The Shutdown Environment is stored in the Experiment file. 
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Maintenance and Inspection Procedures 
 
Monthly Inspection 
 

1) Check integrity of all electrical connections. 

2) Check fluid levels in pumps (where applicable). 

3) Check color of fluid in pumps (where applicable). 

4) Check functionality of all pumps and pressure Gauges. 

5) Check Sampling performance of any sampling inlets. 

 

Half Yearly Inspection 
 

1) Check integrity of all electrical connections. 

2) Check all cooling fans and vent holes for obstructions. 

3) Check fluid levels in pumps (where applicable). 

4) Check color of fluid in pumps (where applicable). 

5) Check functionality of all pumps and pressure Gauges. 

6) Check Sampling performance of any sampling inlets. 

7) Check system calibration, DeltaM and Resolution. 

8) Check operation and calibration of SEM. 

 

Annual Inspection 
 

1) Check integrity all electrical connections and cables. 

2) Check all covers are fitted correctly. 

3) Change fluids in pumps (where applicable). 

4) Change Tip Seal Kits in Edwards Scroll Pumps (where applicable). 

5) Check functionality of all pumps and pressure Gauges. 

6) Check Sampling performance of any sampling inlets. 

7) Check operation of any valves. 

8) Check operation of Filaments. 

9) Check system calibration, DeltaM and Resolution. 

10) Check Mass alignment. 

11) Check operation and calibration of SEM. 

12) Check calibration of system against external Gauge. 

13) Check stability of instrument. 
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Configuring Auxiliary Inputs on HAL 7 MSIU via MASsoft 

Configuring the Auxiliary Inputs on the HAL 7 MSIU can be done via MASsoft.  The 

procedure for this is as follows:- 

With the MSIU and PC connected open MASsoft and select Control Tabs on the left of the 

main window, selecting the Status Tab will show the instrument status as per the screenshot 

below. 

 

 

If you then right click on the Auxiliary Inputs text it opens a small window below, to allow you 

to configure the Auxiliary Input. 
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Once you select configure it opens the Auxiliary Input Editor to allow you to configure 

Auxiliary 1 or Auxiliary 2 by selecting the appropriate Tab, see screenshot below. 

 

Selecting the appropriate tab allows you to input the settings for the Auxiliary input and 

configure it for your specific requirements.  This is dependent on the operation you wish the 

input to perform, and also the output of the device being connected to the input. 
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Configuring Auxiliary Inputs on HAL 7 MSIU Manually 

 
- Close MASsoft. 
- Click the Windows Start Menu->Programs->Accessories->Windows Explorer 
- Browse to C:\Program Files\Hiden Analytical\MAssoftPro\. 
- Delete the file called WR13156.mas (it might appear as WR13156 depending on your view 
preferences). 
 
Next I suggest configuring the auxiliary input manually using the MSIU 
Test application. This configures the device inside the MSIU directly rather than going via the 
Auxiliary Input editor in MASsoft. 
 
These instructions are for a serial connection. If you are using a network or other connection 
then enter the appropriate settings where required. 
 
- Click the Windows Start Menu, then select Program->Hiden Applications->MSIU Test. 
- The MSIU Test window will be displayed. 
- Click the Settings->Serial... menu item. 
- The Serial Settings dialog box will be displayed. 
- Select the appropriate COM port from the drop-down list labeled Port. 
- Select 115200 from the drop-down list labeled Baud Rate. 
- Click OK 
- You can now enter commands into the text box at the bottom left of the MSIU Test window. 
 
- Type the following commands, pressing enter after each line. 
 
pset aux1_name Temperature 
pset aux1_units degC 
pset aux1_cal 1000000 -93.0243 
pset aux1_limits 0 1000 0.001 
lint Temperature 0 
lini all 
save  
 
- Close MSIU Test. 
- Open the Comms Configuration Utility. 
- Select MASsoft, then click Next>. 
- Select the option labeled 'Select an instrument for re-interrogation', then click Next>. 
- Select instrument WR13214, then click Next>. 
- Select the option labeled 'Exit the configuration utility', then 
click Next>. 
- Start MASsoft. 
- Start your experiment. 
 
See the RC RGA/PIC Analyser Operator's Manual; Appendix A : Configuring the Auxiliary 
Analogue Inputs for further information. 
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Analogue SEM Detector Calibration 
 
Calibration Procedure 
The following procedure can be used to calibrate the SEM detector with respect to the 
Faraday detector. 
 
Note: 
If the SEM detector is to be tuned on a regular basis it is recommended to set up a file for 
this purpose. 
 

1. Select Gallery from the MASsoft Control Tabs. 
 

2. Select Profile. 
 

 
 

3. Set the Start mass to equal m-1.  
Where m is the mass for which the SEM is to be calibrated. 
 

4. Set the Stop mass to equal m+1. 
 

5. Set the Samples per amu to 10. 
 

6. Check continuous scanning. 
When started, the scan will repeat until stopped by the user. 
 

7. Set the detector to Faraday. 
 

8. Ensure Start scanning is checked. 
 

9. Select OK to start the scan. 
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10. On the view, check the partial pressure of the selected mass is within the range of 
the SEM detector and below its maximum operating pressure. 
 

11. Note the partial pressure of the peak top. 
 

12. Select the MASsoft window toolbar Abort button to stop the scan. 
 

13. Select the Scan Tree window to bring it to the front. 
 

14. Double click the scan tree input device box, in this case Faraday. 
 

15. Select SEM detector in the Available Inputs box, and select OK. 
 

 
 

16. Select the MASsoft window toolbar Start button to start scanning using the 
SEM detector, which will be displayed in the view. 
 

17. Select the view to bring it to the front. 
 

18. Select the MASsoft window Menu Bar, Tune, Detector command.  The SEM tuning 
box will be displayed. 
 

19. Tune the SEM voltage so the top of the selected peak is at the same pressure as the 
previous Faraday detector scan. 
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20. When the SEM voltage is finally set, stop the scan using the MASsoft window toolbar 

Abort button and close the mass spectrometer control window.  This ensures 
the tuned voltage will be used in all subsequent scans when using the File, New and 
Gallery operations. 
 

Regular Calibration of the SEM detector 
 
If the SEM is to be calibrated regularly, the scan tree shown below can be created and a 
View attached to each scan. The scan tree can be saved as a file called SEMCAL for 
example. 
 

 
 

 
Use the following procedure to calibrate the SEM. 
 

1. In the MASsoft window, select, File, Open and select the file SEMCAL. 
 

2. Create views as required, one for each detector and set them side by side. 
 

3. Select the MASsoft window toolbar Start button to start scanning. 
 

4. Select the MASsoft window Menu Bar, Tune, Detector command.  The SEM 
tuning box will be displayed. 

 

5. Tune the SEM voltage to equalize the peak heights in the two views. 
 

6. When the SEM voltage is finally set, stop the scan using the MASsoft window 

toolbar Abort button to stop the scan. 
 

7. On the File menu select Exit, a prompt will appear asking whether the file is to 
be saved. 
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8. Select Yes, the file is then closed and a new SEM voltage becomes the 
default value used for all subsequent scans when using the File, New and 
Gallery operations. 
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Filament and Emission Control Table 

Filament and Emission Control Data measured Electrode PCB (Main PCB).  All are actual 
measurements taken from the MSIU Controller Unit, with and without the filaments selected when the 
system is not collecting any data.  The system is set up as a complete system, all cables connected 
with the filaments selected and deselected using the Shutdown Box, then by selecting the shutdown 
icon on the toolbar. 

Shutdown Box Settings: Select or Deselect Filament, Set Emission 1000uA, Electron Energy 
70.0V, Cage 3.00V for test only 

Please remember to change the voltages back to the original settings after test 

 Test Readings Your Readings 

Test 
Point 

Reference 
Point 

F1 & F2 Off 
(Volts DC) 

F1 On 
(Volts DC) 

F1 & F2 Off  
(Volts DC) 

F1 On 
(Volts DC) 

F2 On 
(Volts DC) 

       

TP 43 TP 73 -5.00 -5.10    

       

TP 72 TP 73 4.99 4.99    

       

TP 37 TP 73 0 -1.00    

       

TP 30 TP 73 -3.73 -3.44    

       

TP 18 TP 73 1.234 1.513    

       

TP 47 TP 73 0.02 0.02    

       

TP 48 TP 73 3.73 0.02    

       

TP 26 TP 73 3.74 3.42    

       

TP 55 TP 73 -75.2 -74.7    

       

TP 54 TP 73 -75.1 -74.2    

       

TP 56 TP 73 -75.2 -75.9    

       

TP 71 TP 73 -75.1 -75.1    

       

TP 62 TP 73 -5.00 -5.00    

       

TP 22 TP 73 -4.97 -4.97    

       

TP 1 TP 73 24.05 24.04    

       

TP 4 TP 73 24.03 24.04    

       

TP 8 TP 73 24.07 24.07    

       

TP 52 TP 73 0.13 0.13    

       

TP 69 TP 73 5.01 5.01    

       

TP 75 TP 73 14.94 14.93    

       

TP 70 TP 73 -14.94 -14.95    
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Filament Removal and Replacement Procedure 
 
Filament Replacement 
 
Tools required 
Pair of tweezers 
Jeweler’s Screwdriver. 
 
 

 
 

To change the filament assembly: 
 

1. Shut down the RC RGA system and the host vacuum system. 
 

2. Disconnect the RF Head from the RGA Probe. 
 

3. Disconnect the SEM supply cable from the Probe. 
 

4. Remove the RGA Probe from the host vacuum system.  Depending on the Probe 
base flange type, two 10mm or two 13mm spanners will be required.  Leave the used 
copper gasket in place as it will protect the flange knife edge.  Place the Probe 
assembly on a clean, flat work surface. 

 
5. Slacken, but do not remove, the three peripheral screws clamping the filament leads 

to the assembly. 
 

6. Slide the leads away from the screws. 
 

7. Remove the two screws retaining the mounting plate. 
 

8. Lift off the filament assembly. 
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9. Place the new filament assembly in position.  Ensure that the new filament assembly 
is fitted in the same orientation as the assembly removed in Step 4. 

 
10. Refit the two mounting screws. 

 
11. Reconnect the three filament leads. 

 
12. Check visually for any connecting leads which may be electrically shorted to other 

parts of the Probe. 
 

13. With a suitable meter, check that the resistance between the Filament 1 copper lead 
and the filament plate (Filament common) and between the Filament 2 lead and the 
filament plate is approximately 1 ohm. See Figure 6.2. The filament and its leads 
must have 

 
14. NO electrical contact with any other part of the Probe. 

 
15. Re-fit the Probe onto the chamber. 

 
16. MUST BE check for short circuits before fitting the RF or Amplifier Head. 
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Contamination Status Form 
 

NOTE:  Under the Control of Substances Hazardous to Health Regulations 1994, Hiden Analytical Inc has a duty to control it’s 
employees exposure to all substances hazardous to health.  In addition, other employers have a similar duty under those Regulations, 
towards non-employees who may be affected by their handling of hazardous substances used by that employer.  Information supplied on this 
form about the composition of any contaminants/deposits on equipment returned by you will be used to help discharge both these 
requirements. If there are any difficulties completing  this form, please contact Hiden Analytical Inc for advice  Ian.Tyrer@hideninc.com  

  

Item type:  

Serial No.  

Process used: 

 

 

  

Is it possible that any part of the equipment  is contaminated 
e.g with process deposits? 

yes no 

Are any of these materials: carcinogens? X yes no 

 corrosive? C yes no 

 radioactive? R yes no 

 toxic? T yes no 

If so, please mark the contaminants with X, C, R or T in the list below 

 

Please list possible contaminants/deposits below: 

 

 

 

 

 

 

 
 

Signature of Safety Officer  
  

Name (please print)  
  

Position  (please print)  
  

Customer: 
 
 
 
 
 

Date returned: 

 

mailto:Ian.Tyrer@hideninc.com
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Notes 
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